Revisions

* The manual number is noted at the lower left of the back cover.

<table>
<thead>
<tr>
<th>Print Date</th>
<th>*Manual Number</th>
<th>Revision</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sep., 1997</td>
<td>IB (NA)-66791-A</td>
<td>First printing</td>
</tr>
<tr>
<td>Dec., 1997</td>
<td>IB (NA)-66791-B</td>
<td>Addition</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Section 1.4</td>
</tr>
<tr>
<td>Oct., 2000</td>
<td>IB (NA)-66791-C</td>
<td>Addition</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Section 3.1</td>
</tr>
<tr>
<td>Jun., 2004</td>
<td>IB (NA)-66791-D</td>
<td>Partial correction</td>
</tr>
<tr>
<td></td>
<td></td>
<td>About the Manuals</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Addition</td>
</tr>
<tr>
<td></td>
<td></td>
<td>WARRANTY</td>
</tr>
</tbody>
</table>

This manual confers no industrial property rights or any rights of any other kind, nor does it confer any patent licenses. Mitsubishi Electric Corporation cannot be held responsible for any problems involving industrial property rights which may occur as a result of using the contents noted in this manual.
# Introduction

Thank you for purchasing the Mitsubishi Graphic Operation Terminal.

Before using the equipment, please read this manual carefully to develop full familiarity with the functions and performance of the graphic operation terminal you have purchased, so as to ensure correct use.

Please forward a copy of this manual to the end user.

## Contents

<table>
<thead>
<tr>
<th>1. Overview</th>
<th>1-1–1-5</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.1 Configuration of the Manual</td>
<td>1-1</td>
</tr>
<tr>
<td>1.2 Structure and Guide to the Use of This Manual</td>
<td>1-2</td>
</tr>
<tr>
<td>1.3 Abbreviations and Symbols Used in This Manual</td>
<td>1-4</td>
</tr>
<tr>
<td>1.4 Product Configuration</td>
<td>1-5</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>2. System Configuration</th>
<th>2-1–2-2</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.1 System Configuration When Using the SW3NIW-A8GOTP</td>
<td>2-1</td>
</tr>
<tr>
<td>2.2 Describes the Operation with Windows 95</td>
<td>2-2</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>3. Installing the Software Package</th>
<th>3-1–3-3</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.1 Installing the GOT800PSET</td>
<td>3-1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>4. Starting Up the Graphics Software</th>
<th>4-1</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.1 Booting the SW3NIW-A8GOTP</td>
<td>4-1</td>
</tr>
<tr>
<td>4.2 Exiting the Graphics Software</td>
<td>4-1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>5. Basic Operations and Text Input with the Mouse and Keyboard</th>
<th>5-1–5-2</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.1 Using the Mouse and Keyboard</td>
<td>5-1</td>
</tr>
<tr>
<td>5.2 Short-cut Keys Using [Ctrl]</td>
<td>5-1</td>
</tr>
<tr>
<td>5.3 Access Keys</td>
<td>5-2</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>6. Learning the Screen Configuration</th>
<th>6-1–6-15</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.1 Title Bar</td>
<td>6-2</td>
</tr>
<tr>
<td>6.2 Menu Bar and Drop-down Menus</td>
<td>6-3</td>
</tr>
<tr>
<td>6.3 Tool Bar 1</td>
<td>6-4</td>
</tr>
<tr>
<td>6.4 Tool Bar 2</td>
<td>6-4</td>
</tr>
<tr>
<td>6.5 Status Bar</td>
<td>6-5</td>
</tr>
<tr>
<td>6.6 Scroll Bars</td>
<td>6-5</td>
</tr>
<tr>
<td>6.7 Control Menu Box</td>
<td>6-6</td>
</tr>
<tr>
<td>6.8 Command Box</td>
<td>6-7</td>
</tr>
<tr>
<td>6.9 Icon Buttons</td>
<td>6-8</td>
</tr>
<tr>
<td>6.10 Maximum Display Button</td>
<td>6-9</td>
</tr>
<tr>
<td>6.11 Return to Original Size Button</td>
<td>6-10</td>
</tr>
</tbody>
</table>
6.12 Changing the Window Size ................................................................. 6-11
6.13 Switching Application Windows ......................................................... 6-12
6.14 Base Screen Windows and Window Screen Windows ....................... 6-13
   6.14.1 Base Screen Windows .................................................................. 6-13
   6.14.2 Window Screen Windows ............................................................. 6-15

7. Learning Basic Dialog Box Operations ................................................. 7-1~7-4
   7.1 Setting Dialog Boxes ....................................................................... 7-1
   7.2 Setting the Various Items ............................................................... 7-2
   7.3 Message Dialog Boxes .................................................................... 7-3
   7.4 Information Dialog Boxes .............................................................. 7-4
   7.5 Critical Dialog Boxes ..................................................................... 7-4

8. Menu Configuration .............................................................................. 8-1~8-3
About the Manuals

The following product manuals are available. Please use this table as a reference to request the appropriate manual as necessary.

## Related Manuals

<table>
<thead>
<tr>
<th>Manual Name</th>
<th>Manual No. (Model Code)</th>
</tr>
</thead>
<tbody>
<tr>
<td>A870GOT Graphic Operation Terminal User's Manual</td>
<td>IB-66628 (1DM050)</td>
</tr>
<tr>
<td>This describes the specifications and performance of the A870GOT main module, as well as the hardware configuration, procedures for installing optional modules, operation in on-line mode, error codes, and troubleshooting guidelines. (Sold separately)</td>
<td></td>
</tr>
<tr>
<td>A850GOT Graphic Operation Terminal User's Manual</td>
<td>IB-66669 (1DM038)</td>
</tr>
<tr>
<td>This describes the specifications and performance of the A850GOT main module, as well as the hardware configuration, procedures for installing optional modules, operation in on-line mode, error codes, and troubleshooting guidelines.</td>
<td></td>
</tr>
<tr>
<td>A852GOT Graphic Operation Terminal User's Manual</td>
<td>IB-66767 (1DM042)</td>
</tr>
<tr>
<td>This describes the specifications and performance of the A852GOT main module, as well as the hardware configuration, procedures for installing optional modules, operation in on-line mode, error codes, and troubleshooting guidelines. (Included in the A852GOT)</td>
<td></td>
</tr>
<tr>
<td>A853GOT Graphic Operation Terminal User's Manual</td>
<td>IB-66785 (1DM044)</td>
</tr>
<tr>
<td>This describes the specifications and performance of the A853GOT main module, as well as the system configuration. (Included in the A853GOT)</td>
<td></td>
</tr>
<tr>
<td>SW3NIW-A8GOTP Graphic Settings Software Package Operating Manual (Introductory Manual)</td>
<td>IB-66792 (1DM177)</td>
</tr>
<tr>
<td>This manual is designed for the first-time user of the GOT. It describes how to create monitor screens with the A8GOTP, how to send monitor data to the GOT, and what the various screen displays mean. (Sold separately)</td>
<td></td>
</tr>
<tr>
<td>SW3NIW-A8GOTP Graphic Settings Software Package Operating Manual (Monitor Screen Creation Manual)</td>
<td>IB-66793-A (1DM176)</td>
</tr>
<tr>
<td>This describes procedures for creating monitor screens, monitor functions that can be used with the GOT, procedures for setting the monitor functions, precautions to be observed when creating monitor screens, and precautions to be observed when appropriating conventional GOT monitor data for use with the GOT. (Sold separately)</td>
<td></td>
</tr>
<tr>
<td>SW3NIW-A8GOTP Graphic Settings Software Package Operating Manual (Data Transmission/Debugging/Document Creation Manual)</td>
<td>IB-66794-A (1DM175)</td>
</tr>
<tr>
<td>This manual describes the following items.</td>
<td></td>
</tr>
<tr>
<td>(1) Procedures for downloading project data to the GOT and uploading data from the GOT</td>
<td></td>
</tr>
<tr>
<td>(2) Procedures for installing the operating system in the A870GOT</td>
<td></td>
</tr>
<tr>
<td>(3) Procedures for using the A8GOTP as a virtual PC and for debugging the GOT</td>
<td></td>
</tr>
<tr>
<td>(4) Procedures for outputting created monitor data as a completed document</td>
<td></td>
</tr>
<tr>
<td>(Sold separately)</td>
<td></td>
</tr>
<tr>
<td>Manual Name</td>
<td>Manual No. (Model Code)</td>
</tr>
<tr>
<td>----------------------------------------------------------------------------</td>
<td>------------------------</td>
</tr>
<tr>
<td><strong>GOT800 Series Operating Manual</strong></td>
<td>IB-66796 (1DM181)</td>
</tr>
<tr>
<td><em>(Expanded Functions Manual)</em></td>
<td></td>
</tr>
<tr>
<td>This manual describes the operation procedures for using system monitor</td>
<td></td>
</tr>
<tr>
<td>functions, monitor functions for special function modules, and the</td>
<td></td>
</tr>
<tr>
<td>dedicated monitor screens used with the circuit monitor functions.</td>
<td></td>
</tr>
<tr>
<td><em>(Sold separately)</em></td>
<td></td>
</tr>
<tr>
<td><strong>SW3NW-A8GOTP Graphic Settings Software Package Operating Manual</strong></td>
<td>IB-66795 (1DM178)</td>
</tr>
<tr>
<td><em>(Report Functions Manual)</em></td>
<td></td>
</tr>
<tr>
<td>Describes procedures to draw grid lines, set and edit report data using</td>
<td></td>
</tr>
<tr>
<td>the report function.</td>
<td></td>
</tr>
<tr>
<td><em>(Sold separately)</em></td>
<td></td>
</tr>
<tr>
<td><strong>Other's Programmable Controller • Bar-Code Connection System Manual</strong></td>
<td>IB-66797 (1DM143)</td>
</tr>
<tr>
<td>This describes the system configurations and setting method when GOT is</td>
<td></td>
</tr>
<tr>
<td>connected to other's programmable controller • bar-code.</td>
<td></td>
</tr>
<tr>
<td><em>(Sold separately)</em></td>
<td></td>
</tr>
</tbody>
</table>
Chapter 1

Overview
1. Overview

This manual describes the SW3NIW-A8GOTP system configuration, the procedures for installing the system, the screen configuration, and the basic operations involving dialog boxes.

1.1 Configuration of the Manual

This manual consists of eight chapters, which mainly describe startup procedures and the names of the various screens, as well as basic operations involving dialog boxes.

Chapter 1
Describes the configuration of the manual.

Chapter 2
Describes the system configuration when the graphics software is used.

Chapter 3
Explains how to install the software package.

Chapter 4
Explains how to start up and exit the graphics software.

Chapter 5
Explains the use of the keyboard and mouse in the graphics software.

Chapter 6
Describes the configuration of screens in the graphics software.

Chapter 7
Describes the operations used with the various dialog boxes.

Chapter 8
Describes menu configurations.
1.2 Structure and Guide to the Use of This Manual

When this graphics software is purchased, it comes with six operating manuals. Manuals are categorized according to the purpose for which they are used. Please read the manual that corresponds to your particular objective in order to become familiar with the operations and functions of the software.

---

**SW3NIW-A8GOTP Operating Manual**

- Install the graphics software in the computer.
- Start up the graphics software.
- Learn fundamental information and basic operations for the graphics software.

- Create simple graphics, monitor using the GOT, and learn the flow of a series of operations.

- Actually create screens for monitoring using the GOT.
  - Drawing graphics
  - Sprite settings
- Edit the data which has been created.

- To perform report function, create the report data.
  - Create ruled lines.
  - Set the report data.
  - Edit the report data.
1. Overview

- Install the OS program and communication driver in the GOT.
- Download created graphics to the GOT.
- Debug graphics between the computer and GOT.
- Create data documents.

Each of GOT User's Manual

- Install optional modules in the GOT.
- Connect the GOT and PC CPU.
- Find out how to attach the GOT and its external dimensions.
- Select a model.
### 1.3 Abbreviations and Symbols Used in This Manual

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graphics software</td>
<td>This refers to the SW2NIW-A8GOTP.</td>
</tr>
<tr>
<td>Computer</td>
<td>This refers to the peripheral device in which the graphics software has been installed.</td>
</tr>
<tr>
<td>A870GOT</td>
<td>This refers to the A870GOT Graphic Operation Terminal</td>
</tr>
<tr>
<td>A85□</td>
<td>This refers to the A850GOT/A851GOT/A852GOT/A853GOT.</td>
</tr>
<tr>
<td>GOT</td>
<td>This refers to the A870GOT/A850GOT/A851GOT/A852GOT/A853GOT.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>□□□□</td>
<td>This indicates a command on a menu.</td>
</tr>
<tr>
<td>□□□□</td>
<td>This is the icon for the Tool Bar 1.</td>
</tr>
<tr>
<td>[ ]</td>
<td>This indicates a displayed dialog box.</td>
</tr>
<tr>
<td>▼ ▼ ▼ ▼</td>
<td>This indicates an item in a dialog box for which a setting can be entered.</td>
</tr>
<tr>
<td>□□□□</td>
<td>This indicates a dialog box command button.</td>
</tr>
<tr>
<td>Enter Tab</td>
<td>These are keys on the personal computer keyboard.</td>
</tr>
<tr>
<td>□□□□</td>
<td>This indicates an item which can be referenced in this manual.</td>
</tr>
<tr>
<td>Mouse</td>
<td>This indicates an operation done using the mouse.</td>
</tr>
<tr>
<td>Keyboard</td>
<td>This indicates an operation done using the keyboard.</td>
</tr>
<tr>
<td>POINT</td>
<td>This indicates that the information is particularly important.</td>
</tr>
<tr>
<td>□□□□</td>
<td>This indicates the tab name for a dialog box.</td>
</tr>
</tbody>
</table>
1.4 Product Configuration

Please check to make sure that the following products have been included with the equipment you have purchased.

- SW3NIW-GOT800PSET

Floppy disks: 11
Manuals: 7

Software configuration

<table>
<thead>
<tr>
<th>Graphics software</th>
<th>SW3NIW-A8GOTP : 6 disks</th>
</tr>
</thead>
<tbody>
<tr>
<td>System program</td>
<td>SW3NIW-A8SYSP : 3 disks</td>
</tr>
<tr>
<td>Special module monitor data</td>
<td>SW3NIW-A8GMDP : 2 disks (SW3NIW-A8GMDP 1/2 is for Japanese mode)</td>
</tr>
</tbody>
</table>

- Introductory manual
- Startup manual
- Monitor screen creation manual
- Report functions manual
- Debugging manual

- Expanded functions manual
- Other's programmable controller · bar-code connection system manual
Chapter 2

System Configuration
2. System Configuration

2.1 System Configuration When Using the SW2NIW-A8GOTP

Main module : Personal computer which can run the Microsoft Windows Ver. 3.1
Main memory : 4 MB min. required (8 MB or more recommended)
Hard disk : Available memory of at least 10 MB required in order to install program
CRT : Any CRT which can be connected to the main module and with which the
Japanese version of Microsoft Windows Ver. 3.1 can be used
Mouse : Any mouse which can be used with a Windows computer

* Windows 3.1, Windows 95 is a trademark of Microsoft Corporation (U.S.).
2.2 Describes the Operation with Windows 95

The graphics software runs normally on Windows 95.

However, do not switch the program, file, or window using the task bar displayed at the bottom of the desktop when booting the graphics software.

When booting the graphics software, switching windows using the task bar may cause the data in the currently open dialog box to be deleted.

We recommend setting the task bar to NOT DISPLAY when using the graphics software (this automatically hides the task bar).
Chapter 3

Installing the Software Package
3. Installing the Software Package

3.1 Installing the GOT800PSET

Describe the way to install GOT800PSET.

1. Turn on the power supply to the computer.
2. Start up MS-Windows Ver. 3.1 or Windows 95.
3. Insert the floppy disk in the drive of the SW3NIW-A8GOTP 1/6.
   Check the drive into which the disk has been inserted.
4. Execute [Set up-exe] on the floppy disk.
5. After setting ① to ⑥ on the screen below, click on [Install].
   The installation process begins.

[ Screen to be displayed ]

GOT Setup

Setup will place SW3NIW-GOT800PSET into the following
directories, which will create on your hard disk.
If you want to install SW3NIW-GOT800PSET in different
directories and/or drives, type the name of the directories.

① SW3NIW-A8GOTP
   Install to: C:\A8GOTP
② SW3NIW-A8SYSYP
   Install to: C:\A8GOTP\OS
③ SW3NIW-A8GMDP
   Install to: C:\A8GOTP\A8GMDP

④ Install
⑤ Item Select...
⑥ Browse
⑦ Draw, Report
⑧ OS Select...
⑨ Unit Select...
⑩ Exit Setup

 POINT

Depending on the Windows settings, the displayed screen messages may be in English. If you want to change them to Japanese, make the following settings, and then follow the procedure above to install.

<table>
<thead>
<tr>
<th>Item</th>
<th>Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>When using Windows 95</td>
<td>Click &quot;Control Panel&quot; – &quot;Regional Settings&quot;, then select &quot;Japanese&quot;</td>
</tr>
<tr>
<td>When using Windows 3.1</td>
<td>Click &quot;Control Panel&quot; – &quot;International&quot; – &quot;Country&quot;, then select &quot;Japan.&quot;</td>
</tr>
</tbody>
</table>
[Setting contents]

1. Check box

Place an "X" mark in the check box of SW3NIW-A8GOTP, SE3NIW-A8SYS, or SW3NIW-A8GMDP.

(The check box of SW3NIW-A8GMDP does not need to be selected when the special function module monitor function is not being used.)

2. Select Item button

Set the item to set up and sample screen to install.

3. Browse button

Click on Browse, specify the installation destination password of the SW3NIW-A8GOTP, SW3NIW-SYSP, or SW3NIW-A8GMDP.
④ **OS Select** button
Clicking on **OS Select**, select the GOT to use, OS program and communication driver to be installed in the [Item Select] dialog box.

**Select Item**

Please click left button to move items from 'Install' / 'Not Install' to 'Not install' / 'Install'.

<table>
<thead>
<tr>
<th>Got Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>A97R/BS18GOT</td>
</tr>
</tbody>
</table>

Not install:

Install:

- Standard monitor
- ROM_BIOS
- System monitor
- Sp. unit monitor
- MELSEC-A Ladder monitor
- MELSEC-FX Ladder monitor

Select the function which will be installed or not by clicking

⑤ **Module Select** button
Clicking on **Module Select**, select the special function module monitor data to be installed in the [Item Select] dialog box.

**Select Item**

Please click left button to move items from 'Install' / 'Not Install' to 'Not install' / 'Install'.

<table>
<thead>
<tr>
<th>Not install:</th>
</tr>
</thead>
<tbody>
<tr>
<td>A62DA-S1</td>
</tr>
<tr>
<td>A15S2DA</td>
</tr>
<tr>
<td>A616DAV, A616DAI</td>
</tr>
<tr>
<td>A15S8DAV, A15S8DAI</td>
</tr>
<tr>
<td>A6BD</td>
</tr>
<tr>
<td>A6BADN</td>
</tr>
<tr>
<td>A15S8AD</td>
</tr>
<tr>
<td>A64D</td>
</tr>
<tr>
<td>A616AD</td>
</tr>
<tr>
<td>A15S4AD</td>
</tr>
<tr>
<td>A616TD</td>
</tr>
</tbody>
</table>

Install:

Select the function which will be installed or not by clicking

3 - 3
Chapter 4

Starting Up the Graphics Software
4. Starting Up the Graphics Software

4.1 Booting the SW3NIW-A8GOTP

Turn on the power supply to the computer.

Start up MS-Windows Ver. 3.1.

Move the cursor to the SW3NIW-A8GOTP icon and click on it.

The graphics software program is booted.

4.2 Exiting the Graphics Software

Mouse

1. Move the cursor to the Project menu and click on it.
2. Move the cursor to [Exit] and click on it.

Exiting from the control box in the application window

1. Move the cursor to the control box in the application window and click on it.
2. Move the cursor to [Close] and click on it.
Chapter 5

Basic Operations and Text Input with the Mouse and Keyboard
5. Basic Operations and Text Input with the Mouse and Keyboard

This chapter explains the use of the mouse and keyboard in the graphics software.

5.1 Using the Mouse and Keyboard

<table>
<thead>
<tr>
<th>Operation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click</td>
<td>Click the mouse button once and immediately release it.</td>
</tr>
<tr>
<td>Double-click</td>
<td>Click the mouse button twice in rapid succession.</td>
</tr>
<tr>
<td>Drag</td>
<td>Hold down the mouse button and move the mouse.</td>
</tr>
</tbody>
</table>

5.2 Short-cut Keys Using [Ctrl]

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + Z</td>
<td>Undo</td>
<td>Same operation as the [Undo] command on the Edit menu</td>
</tr>
<tr>
<td>Ctrl + X</td>
<td>Cut</td>
<td>Same operation as the [Cut] command on the Edit menu</td>
</tr>
<tr>
<td>Ctrl + C</td>
<td>Copy</td>
<td>Same operation as the [Copy] command on the Edit menu</td>
</tr>
<tr>
<td>Ctrl + V</td>
<td>Paste</td>
<td>Same operation as the [Paste] command on the Edit menu</td>
</tr>
<tr>
<td>Ctrl + N</td>
<td>New</td>
<td>Same operation as the [New] command on the Project menu</td>
</tr>
<tr>
<td>Ctrl + O</td>
<td>Open</td>
<td>Same operation as the [Open] command on the Project menu</td>
</tr>
<tr>
<td>Ctrl + P</td>
<td>Print</td>
<td>Same operation as the [Print] command on the Project menu</td>
</tr>
<tr>
<td>Ctrl + S</td>
<td>Save</td>
<td>Same operation as the [Save] command on the Project menu</td>
</tr>
</tbody>
</table>
5.3 Access Keys

Items on the various menu titles are followed by initial letters which can be used to select menu items from the keyboard, without having to use the mouse.

**Menu bar access key**

Entering "P" displays the drop-down menu under the Project menu.

**Drop-down menu access key**

Entering "C" closes the screen window.
Chapter 6

Learning the Screen Configuration
6. Learning the Screen Configuration

The screen for the graphics software is configured as shown below.

- Application window control menu box
- Application window title bar
- Application window icon button
- Application window maximum display button
- Menu bar
- Tool bar 1
- Tool bar 2
- Screen window control menu box
- Screen window title bar
- Screen window maximum display button
- Screen window icon button
- Scroll bar arrow
- Status bar

Please select figures or sprites. [[ No title ]] [X-243, Y=55]
6.1 Title Bar

This is where the title of the window is displayed. The title bar can be moved anywhere on the screen by placing the cursor on it and dragging it.

There are two title bars in the graphics software: one for the application window, and one for the screen window.

Also, the screen window is divided into two parts, a base screen window and a window screen window, each with its own title bar.

1. Application window title bar

2. Screen window title bar

   1. Base screen window title bar

   2. Window screen window title bar

Mouse

The screen can be displayed in its maximum size by placing the cursor on the title bar and double-clicking on it. If the maximum size is already displayed, double-clicking on the title bar or clicking on the mark returns the display to the original size.

(Section 6.11, “Return to Original Size Button”)
6.2 Menu Bar and Drop-down Menus

The names of menus that can be used with the graphics software are displayed on the menu bar.

Moving the cursor to the menu to be selected and clicking on it displays the pull-down menu.

POINT
If a command has three dots after it (...), moving the cursor to that command and clicking on it, or entering the access key, displays the dialog box where settings can be entered.

If there is an arrow (↑) displayed to the right of a command on the menu, a command menu can be displayed, as shown below.

Click on [Read Other Data] to display the sub-menu.
6.3 Tool Bar 1

This is where items assigned on the menu bar are displayed as icons.

Names of icons

1. Panel kit
2. Sprite
3. Line
4. Line Freeform
5. Rectangle
6. Polygon
7. Circle
8. Arc
9. Text
10. Paint
11. Cursor (for graphics editing or sprite editing)
12. Cut
13. Copy
14. Paste
15. Group
16. Ungroup
17. Preview
18. Change the window

Mouse
Move the cursor to the desired icon and click on it.

6.4 Tool Bar 2

The attributes of items assigned on the menu bar (lines, patterns, etc.) are displayed on this tool bar.

Mouse
Moving the cursor to the down arrow and clicking on it opens the corresponding drop-down menu for the selected item. Move the cursor to the attribute to be changed, and click on it.
6. Learning the Screen Configuration

6.5 Status Bar

This is displayed at the bottom of the application window, and shows the current operation status, a directory of any project data currently open, and the cursor coordinates.

Please select figures or sprites  B:WASGOTPWUC  X= 0, Y= 0

6.6 Scroll Bars

If the figure which has been drawn does not fit completely within the window, the scroll bars can be used to change the area displayed and view other parts of the figure.

Mouse
Move the cursor to the scroll bar slider and drag it to the desired position, or click on the scroll bar arrow to move the display.

Keyboard
1. The Page Up and Page Down keys can be used to scroll the currently displayed screen upwards or downwards.
2. The CTRL + Page Up and CTRL + Page Down keys can be used to scroll the currently displayed screen to the right or left.
6.7 Control Menu Box

This is used to change the size of the window and move the window, to switch applications, and to close the window.

In the graphics software, there are two control menu boxes: one for the application window, and one for the screen window.

1. Directory of commands in the application window control box

```
<table>
<thead>
<tr>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Restore</td>
</tr>
<tr>
<td>Move</td>
</tr>
<tr>
<td>Size</td>
</tr>
<tr>
<td>Minimize</td>
</tr>
<tr>
<td>Maximize</td>
</tr>
<tr>
<td>Close</td>
</tr>
<tr>
<td>Next</td>
</tr>
</tbody>
</table>
```

Mouse: Move the cursor to the control menu box and click on it.

2. Directory of commands in the screen window control box

```
<table>
<thead>
<tr>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Restore</td>
</tr>
<tr>
<td>Move</td>
</tr>
<tr>
<td>Size</td>
</tr>
<tr>
<td>Minimize</td>
</tr>
<tr>
<td>Maximize</td>
</tr>
<tr>
<td>Close</td>
</tr>
<tr>
<td>Next</td>
</tr>
</tbody>
</table>
```

Mouse: Move the cursor to the control menu box and click on it.

**POINT**

Commands covered by a mask cannot be selected.
6.8 Command Box

This displays a directory of sprites accessed using the icon on the title bar 1.

<table>
<thead>
<tr>
<th>Sprite</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Touch Key</strong></td>
</tr>
<tr>
<td><strong>Lamp</strong></td>
</tr>
<tr>
<td><strong>Numerical Disp.</strong></td>
</tr>
<tr>
<td><strong>Ascii Disp.</strong></td>
</tr>
<tr>
<td><strong>Datalist</strong></td>
</tr>
<tr>
<td><strong>Clock</strong></td>
</tr>
<tr>
<td><strong>Comment</strong></td>
</tr>
<tr>
<td><strong>Alarm History</strong></td>
</tr>
<tr>
<td><strong>Alarm List</strong></td>
</tr>
<tr>
<td><strong>Part Disp.</strong></td>
</tr>
<tr>
<td><strong>Part Move</strong></td>
</tr>
<tr>
<td><strong>Panelmeter</strong></td>
</tr>
<tr>
<td><strong>Level</strong></td>
</tr>
<tr>
<td><strong>Trend Chart</strong></td>
</tr>
<tr>
<td><strong>Line Chart</strong></td>
</tr>
<tr>
<td><strong>Bar Chart</strong></td>
</tr>
<tr>
<td><strong>Numerical Inp.</strong></td>
</tr>
<tr>
<td><strong>Ascii Inp.</strong></td>
</tr>
<tr>
<td><strong>Cursor Move</strong></td>
</tr>
<tr>
<td><strong>Window Pos</strong></td>
</tr>
</tbody>
</table>

**Mouse**

Move the cursor to icon and click on it. Then move the cursor to the desired command and click on it to select it.
6.9 Icon Buttons

Windows can be represented as icons for easy access. With the graphics software, there are two buttons for this purpose: one for application window icons and one for screen window icons.

1. Application window Icon button

Move the cursor to the Icon button and click on it. If the application window is represented by an icon, it will look like this:

2. Screen window Icon button

Move the cursor to the Icon button and click on it. If the screen window is represented by an icon, it will look like this:
6.10 Maximum Display Button

The window size can be expanded to fill the entire screen. With the graphics software, there are two buttons for this purpose: one for the application window, and one for the screen window.

1. Application window Maximum Display button

   ![Application window Maximum Display button](image)

   **Mouse** Move the cursor to the Maximum Display button and click on it.

2. Screen window Maximum Display button

   ![Screen window Maximum Display button](image)

   **Mouse** Move the cursor to the Maximum Display button and click on it.
6.11 Return to Original Size Button

If an application window or a screen window has been enlarged to the maximum display size or has been represented as an icon, this button returns the window to its original size. With the graphics software, there are two buttons for this purpose: one for the application window, and one for the screen window.

1 Application window Return to Original Size button

Mouse Move the cursor to the Return to Original Size button and click on it.

2 Screen window Return to Original Size button

Mouse Move the cursor to the Return to Original Size button and click on it.
6.12 Changing the Window Size

The horizontal and/or vertical size of the window can be changed to any desired size. With the graphics software, there are two buttons for this purpose: one for the application window, and one for the screen window.

1. Application window Change Window Size button

Mouse
Move the cursor to the Change Window Size button and click on it.

2. Screen window Change Window Size button

Mouse
Move the cursor to the Change Window Size button and click on it.
6.13 Switching Application Windows

With this function, a different application can be run without exiting the graphics software. The procedure is outlined below.

**Mouse**

1. Click on the control menu box in the application window.
2. Click on Switch To. When the “Switch Application” dialog box is displayed, double-click on the application to be run.

**Keyboard**

Press Alt + Tab or Alt + Esc to switch applications.

Example of application switching dialog box
6.14 Base Screen Windows and Window Screen Windows

Images of base screen and window screen

6.14.1 Base Screen Windows

These are windows which are used to create the screen data displayed as the GOT base screen. Up to 1,024 base screens can be displayed with the GOT, so 1,024 screens can be created with the graphics software.

(1) A870GOT

The sizes of the base screens are different with the STN/TFT and the EL models.

1) STN/TFT model

2) EL model for A870 GOT

(2) A85□GOT

The screen sizes of the L and STN models are the same.
Message displayed on GOT and displayed on a base screen on the computer

POINT
Up to 1,024 screens can be created, but the number that can actually be created depends on how much memory is available.
6.14.2 Window Screen Windows

These are windows used to create window screen data displayed as pop-up windows on a GOT base screen. Up to 1,024 window screens can be displayed on the GOT, so up to 1,024 screens can be created with the graphics software.

(1) A870GOT

The screen size can be set in the following range.
Minimum size: 99 dots x 83 dots (Drawing graphics in the graphic software or sprite function setting can be made in 96 dots x 64 dots.)
Maximum size: 448 dots x 247 dots (Drawing graphics in the graphic software or sprite function setting can be made in 443 dots x 228 dots.)

Maximum: W446 x L247 dots
Initial value: W316 x L176 dots
Minimum: W96 x L64 dots

Basic range: W640 x L480 (400 for A8GT-70GOT-EW/E3) dots

Setting range for width: Minimum 06 dots, default 316 dots, maximum 446 dots (Settable in any dot units within this range)

Setting range for length: Minimum 64 dots, default 176 dots, maximum 247 dots (Settable in any dot units within this range)

(2) A85□GOT

128 dots
192 dots
Chapter 7

Learning Basic Dialog Box Operations
7. Learning Basic Dialog Box Operations

7.1 Setting Dialog Boxes

The setting dialog boxes consist of command buttons, check boxes, radio buttons, spin boxes, list boxes, text boxes, and tabs. Some of them are where operations are specified by entering numerical values, and some are screen title setting dialog boxes.

[Numerical value display settings] dialog box

[Screen title settings] dialog box
## 7.2 Setting the Various Items

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command button</td>
<td>Command buttons are those such as [OK] and [Cancel], and are clicked to execute the various items they represent.</td>
</tr>
<tr>
<td>Check box</td>
<td>Items in these boxes are executed by clicking on the box to place a check mark in it.</td>
</tr>
<tr>
<td>List box</td>
<td>First the downward arrow <img src="image" alt="arrow" /> is clicked to display the selection list, and then the desired item is selected by clicking on it.</td>
</tr>
<tr>
<td>Text box</td>
<td>Characters are input from the keyboard. If a text box is for numeric input, no other characters should be entered in it. If anything other than a numeric value is input, all subsequent characters input will be ignored.</td>
</tr>
<tr>
<td>Radio button</td>
<td>Items are selected by clicking on the circle.</td>
</tr>
<tr>
<td>Spin box</td>
<td>To input a value directly, click on the box <img src="image" alt="spin" /> and then enter a numeric value from the keyboard.</td>
</tr>
</tbody>
</table>
<pre><code>                                                             | To change the value, click on the up and down arrows.                                                                                                                                                      |
</code></pre>
<p>| Tab             | To switch the displayed tab, click on the location where the set item is displayed.                                                                                                                                 |</p>
7.3 Message Dialog Boxes

If an attempt is made to execute an operation and execution cannot be carried out, a message dialog box is displayed, telling the user why the operation could not be carried out, and requesting confirmation.

1. If the user entered an inappropriate setting or did something incorrectly, the following dialog box is displayed.

<Example>

![Message Dialog Box Example 1]

To close the dialog box, move the cursor to [OK] and click on it.

To move the dialog box, move the cursor to the menu bar and drag it to the desired position.

2. If an incorrect setting has been entered for peripheral equipment, or a peripheral unit is not ready for operation, the following dialog box is displayed.

<Example>

![Message Dialog Box Example 2]

To try the operation again, move the cursor to [Retry] and click on it.

To cancel the operation, move the cursor to [Cancel] and click on it.

To move the dialog box, move the cursor to the menu bar and drag it to the desired position.
7.4 Information Dialog Boxes

When executing an operation, any items which require confirmation by the user or additional instruction are displayed in a dialog box like that shown below.

<Example>

To go ahead and execute the operation, move the cursor to [Yes] and click on it.
To cancel the operation, move the cursor to [No] and click on it.
To move the dialog box, move the cursor to the menu bar and drag it to the desired position.

7.5 Critical Dialog Boxes

If a critical system or application error occurs, a dialog box like that shown below is displayed.

To close the dialog box, move the cursor to [OK] and click on it.
To move the dialog box, move the cursor to the menu bar and drag it to the desired position.
Chapter 8

Menu Configuration
8. Menu Configuration

The commands found on the menu bar are explained here.

**Project**
- **New** ................. Creates new project data.
- **Open** ................ Reads an already existing file.
- **Close** ................ Writes data to a file being edited.
- **Save** .................. Overwrites existing project data in a file being edited with the edited data.
- **Save As** .............. Saves the file currently being edited under a different name and allows editing to be continued.

**Import File**
- **Project** .............. Reads other project data into the project data being edited.
- **Picture** .............. Pastes graphic data in the BMP format into the screen window.
- **AGOTP Data** ........ Outputs setting data, graphic images, and other data to a printer file.
- **Print** ................. Outputs setting data, graphic images, and other data to a printer file.

**Option**
- **File** .................. Specification of the work area, settings for edit files at the time of startup, and other settings are entered here.
- **View** .................. Sets whether or not tool bars and the status bar are to be displayed.
- **Communication** .... Sets the communication port and communication speed.
- **Exit** .................. Exits the AGOTP.

**Edit**
- **Undo** .................. Deletes the last change to the data and returns the data to the status it was in before the last change was made.
- **Cut** .................. Deletes graphics, text, and sprites and stores them on the Clipboard.
- **Copy** .................. Stores the selected graphics, text and sprites on the Clipboard without deleting them from the file.
- **Paste** .................. Pastes graphics, text and sprites stored on the Clipboard.
- **Copy and Paste** ...... Copies the selected graphics and sprites collectively, and pastes them into the edit screen.
- **Edit Text** ............. Changes the character attribute.
- **Edit Vertex** .......... Changes the length of a continuous straight line, or the line around a polygon.

**Object of Selection**
- **Figure** ............... Selects only a figure for editing.
- **Sprite** ............... Selects only a sprite for editing.
- **Figure and Sprite** .... Selects the figure and sprite for which editing.
- **Select All** ........... Selects all of the figures, text and sprites for editing.

**Group**
- **Group** ............... Groups the selected figures or sprites.
- **Ungroup** ............. Cancels the grouping of the selected figures or sprites.

**Rotate/Flip**
- **Flip Vertical** ........ Reverses the upper and lower sides of the selected figure.
- **Flip Horizontal** ...... Reverses the left and right sides of the selected figure.
- **Rotate Left** .......... Rotates the selected figure 90 degrees to the left.

**Align**
- **Center** ............... Aligns the selected figures or sprites in the center.
- **Top** .................. Aligns the selected figures or sprites at the top.
- **Top evenly** .......... Aligns the selected figures or sprites along the top, at even intervals.
- **Bottom** ............... Aligns the selected figures or sprites at the bottom.
- **Left** .................. Aligns the selected figures or sprites at the left.
- **Left evenly** .......... Aligns the selected figures or sprites along the left, at even intervals.
- **Right** ................ Aligns the selected figures or sprites at the right.

**Stacking Order**
- **Bring to Front** ...... Brings the selected figure or sprite to the front screen.
- **Send to Back** ......... Sends the selected figure or sprite to the back screen.

**Attribute**
- **Changes and specifies the attributes of a figure being drawn or a figure already drawn.**
- **Edit Sprite** .............. Corrects, diverts, or deletes a sprite.
- **Replace Devices** ...... Changes all of the specified monitor devices to other devices.
**Draw**
- Panelkit ... Reads, saves, and deletes panel kits.
- Part ... Saves parts displayed with the parts display function and parts movement display function.
- Comment ... Saves comments displayed with the comment display function and alarm list display function.
- Draw Figure
  - Line ... Draws a straight line.
  - Line Freeform ... Draws a continuous straight line.
  - Rectangle ... Draws a rectangle.
  - Polygon ... Draws a polygon.
  - Circle ... Draws a circle or ellipse.
  - Arc ... Draws an arc or elliptical arc.
  - Text ... Inputs a character.
  - Paint ... Paints a polygon or closed area with a selected pattern.
- Data Display
  - Numerical Display ... Sets the numeric display function.
  - Data List ... Sets the data list display function.
  - ASCII Display ... Sets the ASCII display function.
  - Clock ... Sets the clock display function.
- Message Display
  - Comment ... Sets the comment display function.
  - Alarm History ... Sets the alarm history display function.
  - Alarm List ... Sets the alarm list display function.
- Animated Display
  - Parts Display ... Sets the parts display function.
  - Parts Movement ... Sets the parts movement function.
  - Lamp ... Sets the lamp display function.
  - Panelmeter ... Sets the panel display function.
- Graph
  - Trend ... Sets the trend graph display function.
  - Line ... Sets the polygonal graph display function.
  - Bar ... Sets the bar graph display function.
  - Level ... Sets the level display function.
- Touch Key ... Sets the touch switch function.
- Data Input
  - Numerical Input ... Sets the numerical input function.
  - ASCII Input ... Sets the ASCII input function.
  - Cursor Info ... Sets the cursor information function.
  - Window Position ... Sets the position at which the window is displayed on the screen.

**Communication**
- Download
  - Monitor Data ... Downloads project data.
  - Special
    - Function Data ... Downloads monitor data for the special module.
- Upload ... Uploads project data.
- Install
  - OS ... Installs the OS.
  - ROM_BIOS ... Installs the ROM_BIOS.
- Memory ... Displays the contents of the built-in memory and clears the built-in memory.
- Memory Card ... Displays the contents of the memory card, and formats the memory card.
- Debug ... Activates the on-line debugging function.
8. Menu Configuration

**Common**

- **Title**
  - Screen .................. Sets titles and detailed descriptions for base screens and window screens.
  - Project .................. Registers titles and ID numbers for project data.

- **Option**
  - PC Communication ... Sets the high speed for communication.
  - Scr. Switching Device .... Sets the base and window monitor screen switching.
  - Password .................. Registers a password for project data.
  - Hard Copy .................. Sets the hard copy trigger.
  - Operation Panel ........ Sets the operation panel.
  - System Information ...... Checks the device used to confirm GOT operation conditions with the PC CPU.
  - Observe Status ............ Sets the status monitoring function.
  - Alarm History ............ Sets the alarm history display function (Common Setting).
  - GOT Type ................. Sets the GOT type for the screen data to be created.
  - PC Type .................. Sets the connection PC type.

**Screen**

- Load .................. Opens the specified screen window in the application window.
- Clear .................. Closes the specified screen window.
- Clear and Load ............ Closes the screen being edited and opens a different screen.
- Store .................. Saves the screen being edited and allows editing to be continued.
- Store As ................. Changes the number of the screen being edited.
- Scr. Utilize/Delete ........ Diverts/deletes the screen data in the project being edited.
- Preview
  - Image .................. Displays the contents set for the monitor screen as an image when the monitor function is run.
  - Device .................. Displays the name of the monitor device for the monitor function setting.
  - Image and Device .. Displays an image superimposed on a device display.
  - Canvas .................. Displays whatever has been drawn.
  - Sprite ID ............... Displays the sprite ID number being set on the screen.
- Redisplay ............... Selected when a graphic drawn with several windows open at the same time in the graphics software cannot be displayed properly.
- Cascade .................. Displays currently open screen windows as a superimposed display.
- Title ................... Displays all currently open screen windows in a series.
- List Open Screens ........ Activates screens among the currently open screen windows which are to be edited.

**?**

- About .................. Displays the version of the graphics software currently installed.
WARRANTY

Please confirm the following product warranty details before starting use.

1. Gratis Warranty Term and Gratis Warranty Range
   If any faults or defects (hereinafter "Failure") found to be the responsibility of Mitsubishi occurs during use of the product within the gratis warranty term, the product shall be repaired at no cost via the dealer or Mitsubishi Service Company. Note that if repairs are required at a site overseas, on a detached island or remote place, expenses to dispatch an engineer shall be charged for.

   [Gratis Warranty Term]
   The gratis warranty term of the product shall be for one year after the date of purchase or delivery to a designated place.
   Note that after manufacture and shipment from Mitsubishi, the maximum distribution period shall be six (6) months, and the longest gratis warranty term after manufacturing shall be eighteen (18) months. The gratis warranty term of repair parts shall not exceed the gratis warranty term before repairs.

   [Gratis Warranty Range]
   (1) The range shall be limited to normal use within the usage state, usage methods and usage environment, etc., which follow the conditions and precautions, etc., given in the instruction manual, user's manual and caution labels on the product.
   (2) Even within the gratis warranty term, repairs shall be charged for in the following cases.
       1. Failure occurring from inappropriate storage or handling, carelessness or negligence by the user. Failure caused by the user's hardware or software design.
       2. Failure caused by unapproved modifications, etc., to the product by the user.
       3. When the Mitsubishi product is assembled into a user's device, Failure that could have been avoided if functions or structures, judged as necessary in the legal safety measures the user's device is subject to or as necessary by industry standards, had been provided.
       4. Failure that could have been avoided if consumable parts (battery, backlight, fuse, etc.) designated in the instruction manual had been correctly serviced or replaced.
       5. Failure caused by external irresistible forces such as fires or abnormal voltages, and Failure caused by force majeure such as earthquakes, lightning, wind and water damage.
       6. Failure caused by reasons unpredictable by scientific technology standards at time of shipment from Mitsubishi.
       7. Any other failure found not to be the responsibility of Mitsubishi or the user.

2. Onerous repair term after discontinuation of production
   (1) Mitsubishi shall accept onerous product repairs for seven (7) years after production of the product is discontinued. Discontinuation of production shall be notified with Mitsubishi Technical Bulletins, etc.
   (2) Product supply (including repair parts) is not possible after production is discontinued.

3. Overseas service
   Overseas, repairs shall be accepted by Mitsubishi's local overseas FA Center. Note that the repair conditions at each FA Center may differ.

4. Exclusion of chance loss and secondary loss from warranty liability
   Regardless of the gratis warranty term, Mitsubishi shall not be liable for compensation to damages caused by any cause found not to be the responsibility of Mitsubishi, chance losses, lost profits incurred to the user by Failures of Mitsubishi products, damages and secondary damages caused from special reasons regardless of Mitsubishi's expectations, compensation for accidents, and compensation for damages to products other than Mitsubishi products and other duties.

5. Changes in product specifications
   The specifications given in the catalogs, manuals or technical documents are subject to change without prior notice.

6. Product application
   (1) In using the Mitsubishi MELSEC programmable logic controller, the usage conditions shall be that the application will not lead to a major accident even if any problem or fault should occur in the programmable logic controller device, and that backup and fail-safe functions are systematically provided outside of the device for any problem or fault.
   (2) The Mitsubishi general-purpose programmable logic controller has been designed and manufactured for applications in general industries, etc. Thus, applications in which the public could be affected such as in nuclear power plants and other power plants operated by respective power companies, and applications in which a special quality assurance system is required, such as for Railway companies or National Defense purposes shall be excluded from the programmable logic controller applications.
   Note that even with these applications, if the user approves that the application is to be limited and a special quality is not required, application shall be possible. When considering use in aircraft, medical applications, railways, incineration and fuel devices, manned transport devices, equipment for recreation and amusement, and safety devices, in which human life or assets could be greatly affected and for which a particularly high reliability is required in terms of safety and control system, please consult with Mitsubishi and discuss the required specifications.
SW3NIW-A8GOTP Graphic Settings Software Package
Operating Manual (Startup Manual)

GOT
Mitsubishi Graphic Operation Terminal

MODEL
SW3-A8GOTP-O-ST-E

MODEL CODE
1DM179

IB(NA)-66791-D(0406)MEE

Specifications subject to change without notice.

When exported from Japan, this manual does not require application to the Ministry of Economy, Trade and Industry for service transaction permission.

Specifications subject to change without notice.